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What software do I need? 
 
The AutoSplit software requires a full version of Adobe Acrobat Standard or Professional for 
Microsoft Windows. It will not work with free Acrobat Reader software that does not allow 
document editing and modification. The plug-in supports all versions of Adobe Acrobat starting 
from version 6. You can download a free 30 day trial version of AutoSplit from 
http://www.evermap.com/autosplit.asp. If you do not currently own a copy of Adobe Acrobat, 
then you can download a trial version from http://www.adobe.com/downloads. The AutoSplit 
software, once installed, adds several menus to the “Plug-ins” menu in Adobe Acrobat. AutoSplit 
is available in two versions: Standard and Professional. It is recommended to download and 
evaluate the Professional version in order to get a complete overview of the product capabilities. 

What splitting methods are available? 
 
The AutoSplit software supports the following splitting methods: 

• Splitting into equal size documents (equal number of pages per output file) 
• Splitting by bookmarks 
• Extracting pages using manually entered page ranges. 
• Extracting pages that contain specific text or pattern. 
• Splitting at blank pages (Professional version). 
• Splitting at pages with user-specified text or pattern (Professional version). 
• Splitting at pages where text or pattern changes (Professional version). 
• Splitting at pages where text at specific location changes (Professional version). 
• Splitting at pages that contain one of the user-specified keywords (Professional version).  
• Splitting at pages when page size changes (Professional version). 
• Splitting at pages with PDF “rubber” stamps annotations (Professional version). 

What PDF documents can be split? 
 
The AutoSplit software can split the following common types of PDF documents: 

• Documents that contain fixed-length sub-documents such as invoices, letters, pay stubs. 
• Documents that contain variable-length invoices, account statements, letters. 

http://www.evermap.com/autosplit.asp
http://www.adobe.com/downloads
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• Documents that contain bookmarked sub-documents (the first page of each sub-
document is bookmarked). 

• Scanned paper documents where each sub-document is separated by a blank page. 
• Documents that contain pages or ranges of pages with a specific text or pattern. 

The AutoSplit software can process any kind of PDF document that is at least 2 pages long and 
does not have any security access restrictions. If you are planning to split a document by text 
search, then verify that document actually contains searchable text. You can check that by 
searching for a known word or by selecting a text fragment and using Copy/Paste operation to 
copy it into another text editor. Please see the following online tutorial that explains how to 
make scanned paper documents searchable: https://evermap.com/Tutorial_ABM_OCR.asp.  

Where do I start? 
 
Start Adobe Acrobat application and open a PDF file using “File > Open…” menu.  
Next, select “Plug-ins > Split Documents > Split Document…” from the main Acrobat menu to 
open “Split Document Settings” dialog. If you are using new Acrobat interface (2023+), then see 
the following screenshot that explains how to locate Plugins menu: 
 

 

  

https://evermap.com/Tutorial_ABM_OCR.asp
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You should see the Split Document Settings screen below:  

 

What splitting method to choose? 
 
The selection of splitting method depends on the document content and on desired results. This 
document is going to focus on the most common cases of splitting various business documents.  
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Use Case 1: Automatic Splitting into Multiple Documents 
 
The input PDF document contains multiple sub-documents (for example invoices, account 
statements and etc.). The goal is to split a document into multiple documents that contain each 
statement/invoice as a separate file and name it using a text from the first page of each 
document (for example: an account number, a customer ID or person’s name).   

HOW TO SELECT A SPLITTING METHOD: 

1. Does a first page of each variable length sub-document contain “Page 1 of X” text? 
2. Does a first page of each variable length sub-document contain a unique “account 

number” (or similar identifier or text pattern)? 
3. Does each page of the document contain an “account number” ” (or similar identifier 

or text pattern) that is different for each sub-document? 
4. Does each page of the document contain an “account number” ” (or similar identifier 

or text pattern) that is different for each sub-document AND is always located in the 
approximately the same area of the page? 

5. Does a first page of each variable length sub-document have a bookmark? 
6. The document contains sub-documents that all have a fixed length in pages (for 

example: the document is a collection of 1-page long pay stubs or letters). 
7. Is there a blank page separator between each sub-document? 

IMPORTANT: All “Use Separator” splitting methods require AutoSplit Professional version. 

Use Case 2: Extract pages within specific page ranges or text pattern. 
 
The input PDF document contains pages of interest at specific page numbers (or ranges) or 
pages with a certain text or pattern somewhere on the page. The goal is to find and extract all 
these pages into one or more documents.  The number of output documents is fixed at design 
time. The user is responsible for specifying the criteria for pages that need to be extracted into 
every document.   
 
Select “Use manually defined page ranges” method for all projects that fall under this scenario. 
This splitting method is available in both AutoSplit Standard and AutoSplit Professional versions 
of the software.  
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Automatic Splitting into Multiple Documents 
 
Case 1.1 “Use separator: Page with Matching Text”   
Does the first page of each sub-document contain Page 1 of … text? Each sub-document may 
have a different number of pages. If yes, then use “Use separator: Page with Matching Text” 

splitting method: Press “Options…” button 
enter Page 1 of into “Find what” box. The document will be split at pages that contain Page 1 
of text: 

 

Using “Page 1 of” is the very common method for splitting documents. However, if your 
document does not have this kind of page label, then look for text that is only present on the 
first page of each sub-document (1 of, Page 1, INVOICE, ACCOUNT STATEMENT and etc.). If 
there is no such unique text present, then evaluate other more advanced splitting methods 
listed in this manual. 
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Case 1.2 “Use separator: Page with Matching Text”   
Does a first page of each sub-document contain a unique “account number” (or similar 
identifier or text pattern)?  Each sub-document may have a different number of pages.  If yes, 
then use “Use separator: Page with Matching Text” splitting method: 

 
Press “Options…” button and enter a text pattern to split document at. Here is an example for a 
10-digit account number: \d{10}. Make sure to check “Use regular expressions” option: 
 

 

The above text pattern will find every page that contains a 10-digit number and split documents 
at those pages. Modify this text pattern to fit your requirements or email technical support for 
assistance (tech@evermap.com). 
Turn on “Combine page range that match the same text into a single output file” option to 
combine sub-documents with the same “account number” into a single output file.  

mailto:tech@evermap.com
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Case 1.3 “Use separator: Page where Pattern Changes”   
Does each page of the document contain an “account number” (or similar number or text 
pattern) that is different for each sub-document? If yes, then use “Use separator: Page where 
Pattern Changes” splitting method: 

  
Press “Options…” button and enter a text pattern. The example below searches for ACCOUNT 
NUMBER: XXXXXXXX text pattern (for example: ACCOUNT NUMBER: 92310023). The \d{8} part 
of the pattern indicates that it should contain exactly 8 digits.  

 
Some financial documents may contain multiple similar text patterns such as account numbers, 
customer IDs, invoice numbers and etc. Turn on “Search for text only inside a specified area on 
the page” to limit text search to a specific area. Press “Edit Area…” button to define a working 
area.  Turn on “Combine page range that match the same text into a single output file” option if it 
is necessary to combine sub-documents with the same “account number” into a single output 
file.  
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Case 1.4 “Use separator: Page Where Text Changes” 
Does each page of the document contain an “account number”  (or similar identifier or text 
pattern) that is different for each sub-document AND is always located in the approximately the 
same area of the page? If yes, then use “Use separator: Page Where Text Changes” method. 

 
“Press “Options…” button and draw a box around the “signature” text. The document will be split 
at pages where text in this page location is changed. Use “Zoom” tool in the “Select Page Area” 
dialog to zoom in on the text you want to watch for a change and draw a box around it with 
“Select Area” tool. Try to select an area that does not include any other text. If you find that this 
text pattern is not always occurring within the same area, then use Case 1.3 method described 
above. 
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Case 1.5 ”Split By Bookmarks”: Does the first page of each variable length sub-
document have a bookmark? Use “View > Navigational Panels > Bookmarks” menu to open 
“Bookmarks” panel if it is not visible. If yes, then use “Split by Bookmarks” method:

 
If you only want to split a document at top level bookmarks, then enter “1” to “1” level. If you 
want to split a document at every bookmark level, then enter “1” to “N” level (where N is a 
maximum bookmark level in the document).   

Case 1.6 “Split into Equal Size Documents”: The document contains sub-
documents that all have a fixed length in pages (for example: the document is a collection of 1-
page long pay stubs or letters). Use “Equal size documents” splitting method: 

 

Case 1.7 “Split by Blank Image Page”:  Is there a blank page separator between 
each sub-document? If yes, the use “Use separator: Blank Image Page”.   

 
This method is designed for separating PDF files created by scanning paper documents.  Press 
“Options…” button to specify a sample blank page for fine tuning. Select a sample blank page in 
the document use “Select page number” entry and press “Set From Page” button. This function 
will set a blank image threshold based on the level of noise contained in the selected page.  
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Extract pages that contain specific page ranges or text  
 
The input PDF document contains pages of interest at specific page numbers or pages with a 
certain text or pattern somewhere on the page. The goal is to find and extract all these pages 
into one or more documents.  The number of output documents is fixed at design time. The user 
is responsible for specifying the criteria for pages that need to be extracted into every 
document.  Select “Use manually defined page ranges” method for all projects in this use case 
scenario. 

 

 Press “Add Document…” button to create an output document definition. The “Specify Page 
Ranges” dialog will appear on screen to allow initial selection of pages that need to be extracted 
into this output document. You can add more page ranges to the same document or to a new 
document later.  
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Use “Specify Page Ranges” dialog to edit (or delete) each page range definition and fine tune 
additional parameters. This dialog provides a shortcut for most common cases. 

• To specify a page or a page range, enter page numbers separated by commas: 1, 4-8, 
22-24.  

• To specify a reversed page order swap first/last pages:  5-1, 100-1. 
• To specify even or odd pages from a page range add E or D at the end:  1-5E, 1-5D  
• To specify a set of pages that contain a specific word or phrase, enter a search text in 

quotes, e.g.: “Account Statement”. 
• You can specify the same pages multiple times and in any order to create a desired 

output. 

Press “OK” button to close this dialog. You should see a new document added to the output list. 
Here is an example of the output document description for 1,2-3,1-6 entry: 
 

 

Press “Add Output Documents” button again to add another document or press “Add Page 
Range” or “Pages By Text Search” buttons to add additional pages to the same document. 
Here is an example of the output view after adding “Account Statement” text via “Specify 
Pages” dialog as a new document: 
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Double-click on any entry in the list to edit its parameters or select entry and press “Edit Page 
Range…” button. For example, double-click on All pages 2 to 3 (2 Pages) entry. The “Edit Page 
Range” dialog will appear on screen: 

 

Use this dialog to edit starting and ending page numbers, select even/odd pages, reverse page 
order and pad this range with a blank page. A custom watermark can be added to every page of 
this particular page range. Press “From Bookmark” buttons to get a page number from an 
existing bookmark. 
 
Double-click on Document 1 entry to edit output document properties. You can either enter a 
fixed, custom document name or let the plug-in to assign a document name automatically 
(based on output document settings covered later in this manual). You can also specify 
document properties such as “Title”, “Author”, “Subject” and “Keywords”.  
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Double-clicking on Query Set of Pages Matching “Account Statement” entry will bring up 
“Extract Pages by Text Search” dialog where you can edit its parameters: 

 

This dialog allows configuring 3 different page extraction modes: 

• Extract a single page that matches the search criteria (the first found page is used) 
• Extract set of individual pages matching the search criteria (all found pages are used) 
• Extract all page ranges where first and last pages match the search criteria 

You can either enter text to search for (for example, Account Statement) or use powerful 
regular expression syntax to match a text pattern (for example, a 10-digit account number). A 
regular expression, often called a pattern, is an expression that specifies a set of strings and is 
widely used in text processing. Refer to AutoSplit manual or to any widely available online 
resource for syntax details. Here we are going to provide a short list of commonly used regular 
expressions as an example: 
\d{10} – match a sequence of 10 digits. 
\w{5} – match a sequence of 5 digits, letters or underscore. 
\d{3}-\d{2}-\d{4} – match a Social Security Number (3 digits, dash, 2 digits, dash, 4 digits). 
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Output Document Naming 
 
The AutoSplit plug-in allows naming output files using any combination of the different name 
parts including extracting text from each output document and using it as a part of the filename. 

 

Press “Add…” to start defining an output naming scheme and select one of the following 
options: 
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Use “Add…” button repeatedly to add multiple components to the file name. One of the most 
common methods is to use Text From Location option. Use to extract text from a specific page 
location:  
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Specifying Output Options 
 
Press “Output Options…” button to specify additional processing options that come handy in 
many applications: 

 
The “Output Options” dialog will appear on the screen offering many processing options such as 
inserting cover pages, modifying output filenames or overwriting existing files. 
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 Securing Output Documents with Password 
 
Check “Secure output documents” option and press “Security Settings” if you want to secure 
output documents with a password or restrict document editing. 
 

 
 
Select desired security options and enter passwords. All output document will be secured 
according to the specified settings.  
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Creating Index Files 
 
It is often desired to automatically generate a separate text or HTML file that lists every output 
document. This can serve as a processing log or as a handy navigation document to quickly 
open any output file. Check “Create HTML index file” option to create several supplemental 
index files: 
 

 

The software will generate the following index files (InputFilename stands for a name of the 
current input PDF file): 

• InputFilename_filelist.txt – listing all output document names (without a full path) 
• InputFilename_fileindex.htm – a hyperlinked HTML document with links to all output 

files.   

Splitting and Reviewing Results 
 
Once you have specified a desired splitting method and selected output folder and document 
naming convention, you are ready to actually run a splitting process. Press “OK” button in the 
“Split Document Settings” dialog to start processing: 
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The actual processing time may vary greatly depending on the size and complexity of the input 
document. You should see a progress status in the lower right corner of the current document.  
The “AutoSplit Results” dialog appears on screen once a processing is completed: 
 

 

The “Results” dialog will list all output file names that were created during the processing. If 
errors were encountered, then this dialog shows a “View Errors…” button for displaying a list of 
problems. If processing was successful, then press “Open Output Folder” button to close this 
dialog and open an output folder in Windows Explorer: 
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The size of each output document is not directly proportional to the size of the input file divided 
by the number of pages it actually contains. Most PDF files contain a lot of “shared” resources 
such as embedded fonts, background images, navigational elements such as links and 
bookmarks. This additional content sometimes may contribute up to 95% of the document size. 
For example, an input document has 10 pages with a modest amount of text on each page that 
uses several embedded fonts and is about 1Mbyte in size. The fonts in this file may contribute 
up to 900KB of the file size. If this document is split into 10 separate files, then the size of each 
output file is going to be roughly the same as the size of the input document. This is because 
embedded fonts need to be copied into every output file and therefore greatly contribute to the 
output file size. Since each PDF file is unique, the actual results will vary accordingly.  

It is recommended to use “File > Save As…” menu to save a copy of the input document before 
splitting to purge all accumulate changes. Adobe Acrobat always appends modifications to the 
end of the file (if “File > Save” menu is used to save changes) causing the file to grow over time. 
Sometimes, this accumulated change may unnecessarily increase the sizes of output files.  
If you are puzzled why output files are so large, then use “Audit Space Usage” function. Open a 
“PDF Optimizer” dialog in Adobe Acrobat Professional and press “Audit Space Usage” button: 
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The “Audit Space Usage” dialog shows how the file size is distributed among various PDF 
components. In this particular example, only 4.72% of the file size is actually occupied by visible 
document content (text). The biggest contributors are fonts and document overhead.  

Saving and Loading Processing Settings  
 
Press “Save Profile…” button to save a current document splitting parameters into a settings file 
(with APR file extension). You can later restore this exact splitting configuration by using “Load 
Profile…” button and selecting a previous saved file. It is possible to transfer settings from one 
computer to another using APR files to share a particular processing setup between co-workers. 
 

 

Introduction to Text Patterns 
 
The most powerful functionality of AutoSplit comes from the ability to utilize regular expressions 
to define text patterns. A regular expression is a special text string for describing a search 
pattern. You can think of regular expressions as wildcards on steroids. Regular expressions are 
also described in many online resources, some of which have copious examples. There are many 
web sites that serve as online repository of useful regular expressions. The description here is 
intended as introductory documentation only. Please consult the software help manual for 
details. 

Most characters stand for themselves in a pattern and match the corresponding characters in 
the subject. There are 11 characters that have a special meaning (^ $ . * + ? = | \ / ( ) [ ] { }). As 
a rule, if you want to include any of these punctuation characters literally in a regular expression, 
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you must precede them with a \. The most common mistake is using a period without a 
backslash to literally match a period character.  

Character types 

The regular expression syntax provides a special way to define a character that belongs to a 
“class” of characters and use it in the pattern description. Backslash can be used to specify 
generic character types: 

Character 
Class 

Meaning Examples 

\d Matches any decimal digit: 0-9 \d – matches 1 digit 
\d{8} – matches exactly 8 
digits 
\d{2,4} – matches from 2 to 4 
digits 

\D Matches any character that is not a decimal 
digit 

\D – matches any letter or 
space 

\s Matches any whitespace character (space, tab, 
newline) 

\s+ - matches one or more 
whitespace characters 

\w Matches any "word" character (A "word" 
character is any letter or digit or the 
underscore character) 

\w+ - matches one or more 
word characters. For example: 
PO23476 or INVOICE. 

\W Matches any "non-word" character  
[…] Matches any one character between the 

brackets 
[abc] matches one occurrence 
of a, b or c characters 

[^…] Matches any one character not between the 
brackets 

[^XYZ] – matches any 
character that is not X, Y or Z. 
[^\n] – matches any character 
except a newline 

\n A new line character  
^ Matches the start of the text line ^INVOICE – matches word 

INVOICE if it appears at the 
start of the text line. 

$ Matches the end of the text line ^INVOICE \d{8}$ - matches 
the word INVOICE followed by 
a number only if it occupies a 
whole text line. 

\b Matches the word “boundary”. Word 
boundary is not a character, but rather a 
position in the string. It can be beginning or 
ending of the text line, or a space that is 

\bINVOICE\b – matches word 
INVOICE only if it appears as a 
separate word (not inside any 
other text string). 
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adjustment to a “word” character. 
 
Defining Repetitions 

Expression Meaning Examples 
{n,m} Matches the previous item at least n times, 

but no more than m times. 
\d{2,4} – matches from 2 to 4 
digits 

{n,} Matches the previous item n or more times. \d{3,} – matches 3 or more 
digits 

{n} Matches exactly n occurrences of the previous 
item. 

\d{5} – matches exactly 5 
digits 

? Matches zero or one occurrences of the 
previous item. That is, the previous item is 
optional.  

X? – indicates an optional 
letter X. 

+ Matches one or more occurrences of the 
previous item. 

\d+ – matches one or more 
digits 

* Matches zero or more occurrences of the 
previous item. 

\d* –matches zero or more 
digits 

Matching Alternatives 

Vertical bar characters are used to separate alternative patterns. For example, the pattern 
Invoice|Claim matches either "Invoice" or "Claim". Any number of alternatives may appear, and 
an empty alternative is permitted (matching the empty string).  
Examples: 
(541|503)-\d{3}-\d{4} matches phones numbers that start with either 541 or 503 area codes. 
(USA|Canada|EU) matches either US or Canada or EU. 

Examples of Regular Expressions 

Here is a list of common regular expressions that can be used as a starting point for designing 
your own that matches your document or project requirements.  

Expression Meaning 
\d{10} Matches exactly 10 consecutive digits. For example: 9737739890 
ACCOUNT NUMBER: \d+ Matches ACCOUNT NUMBER text that is followed by one or more 

digits 
\d{3}-\d{3}-\d{4} Matches US-style phone number. For example: (541)-760-9260. 
\d{3}-\d{2}-\d{4} Matches US Social Security Number. For example: 507-44-1111 
\d{4} \d{4} \d{4} \d{4} Matches a 16 digit account number (4 groups of 4 digits separated 

with spaces). For example: 1431 8872 0012 4219  
INVOICE \w{5,8} Matches word INVOICE followed by any combination of letters or 
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digits between 5 and 8 characters long. For example: INVOICE 
XY87221 

CUSTOMER ID:  [\w\-
]{8,} 

Matches CUSTOMER ID: followed by any combination of letters, 
digits or a dash symbol that is at least 8 character long. 

(OR|WA|CA) Matches either OR, WA or CA text strings. 
[A-Z0-9._%+-]+@[A-Z0-
9.-]+\.[A-Z]{2,4} 

Matches an email address. For example: John.Doe@mycompany.com 
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Using Batch Processing 
 

The Adobe Acrobat Professional comes with batch processing functionality (called Action Wizard 
in Acrobat X and above) that provides a way to combine various document processing steps 
into multi-step workflows or “actions”. Batch processing is useful when it is necessary to apply 
the same processing to multiple files without manual intervention. 

You can find visual step-by-step instructions on how to create batch sequences ("actions") 
online at: 

For Acrobat Pro DC: http://www.evermap.com/ActionWizardDC.asp  
For Acrobat Pro X: http://evermap.com/ActionWizardX.asp 
For Acrobat Pro XI: http://evermap.com/ActionWizardXI.asp 

How to split files using Action Wizard: http://evermap.com/Tutorial_ASP_ActionWizardDC.asp 
 
It is possible to run AutoSplit from a command-line BAT file or from another application. Please 
see the following online tutorial for details: https://evermap.com/Tutorial_ASP_RunFromBAT.asp.  

 

Getting Help 
 

Contact technical support (mailto:tech@evermap.com?subject=Technical Support Request) for 
help with configuring AutoSplit for your particular document or project. It is always helpful to 
include a sample PDF document.  
 
Check AutoSplit product page for more step-by-step tutorials: 
http://evermap.com/AutoSplit.asp#tutorials 

  

http://www.evermap.com/ActionWizardDC.asp
http://evermap.com/ActionWizardX.asp
http://evermap.com/ActionWizardXI.asp
http://evermap.com/Tutorial_ASP_ActionWizardDC.asp
https://evermap.com/Tutorial_ASP_RunFromBAT.asp
mailto:tech@evermap.com?subject=Technical%20Support%20Request
http://evermap.com/AutoSplit.asp
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Legal Notice 
 

©2005-2024 EverMap Company LLC. All rights reserved. 

How to Split PDF files with AutoSplit ™  

If this guide is distributed with software that includes an end-user agreement, this guide, as well 
as the software described in it, is furnished under license and may be used or copied only in 
accordance with the terms of such license. Except as permitted by any such license, no part of 
this guide may be reproduced, stored in a retrieval system, or transmitted, in any form or by any 
means, electronic, mechanical, recording, or otherwise, without the prior written permission of 
EverMap Company LLC. Please note that the content in this guide is protected under copyright 
law even if it is not distributed with software that includes an end-user license agreement. The 
content of this guide is furnished for informational use only, is subject to change without notice, 
and should not be construed as a commitment by EverMap Company LLC. EverMap Company 
LLC assumes no responsibility or liability for any errors or inaccuracies that may appear in the 
informational content contained in this guide. 

Please remember that existing artwork or images that you may want to include in your project 
may be protected under copyright law. The unauthorized incorporation of such material into 
your new work could be a violation of the rights of the copyright owner. Please be sure to 
obtain any permission required from the copyright owner. 

Notice to U.S. Government End Users. The Software and Documentation are "Commercial 
Items," as that term is defined at 48 C.F.R. §2.101, consisting of "Commercial Computer 
Software" and "Commercial Computer Software Documentation," as such terms are used in 48 
C.F.R. §12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. 
§§227.7202-1 through 227.7202-4, as applicable, the Commercial Computer Software and 
Commercial Computer Software Documentation are being licensed to U.S. Government end 
users (a) only as Commercial Items and (b) with only those rights as are granted to all other end 
users pursuant to the terms and conditions herein. Unpublished-rights reserved under the 
copyright laws of the United States. 

EverMap Company LLC. , 2397 NW Kings Blvd, #159, Corvallis, OR, 97330, USA. 
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